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Introduction

ColorMetrix® ProofPass® is the integration of; 
two successful ColorMetrix software products; test 
targets designed for proofing; specially designed 
pass/fail labels; an optional label printer; optional 
professional services in the form of installation and 
training; and optional instrumentation.  The purpose 
of this document is to provide an overview of how to 
begin productive use of the system quickly. 

This guide has been written with the intent that you 
will be following along step by step. The example 
used in this document will require the output of 
the “standard_gap_colorbar” file located in the 
Targets folder of the ColorMetrix CD. The “standard 
gap colorbar” is also available for download from 
http://www.colormetrix.com/colorbars/ The example 
will also assume you are using either the X-Rite® 
DTP41 or the GretagMacbeth® EyeOne.
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Installation

1. Install drivers for your instrument.
Both the X-Rite DTP41 and the GretagMacbeth 
EyeOne come with a driver installation CD. You 
might need to install the drivers that came with your 
instrument. Consult their documentation for driver 
installation.
Setup for other supported instruments can be found 
on the ColorMetrix website.
 http://colormetrix.com/support/

2. Install the ColorMetrix and Trending Application
The ColorMetrix and Trending Installers can be 
found on the CD that came with your purchase. 
Simply navigate to the CD and run the setup.exe 
in the ColorMetrix and Trending Folders. The setup 
wizard will prompt you through the required steps.
The latest versions are available for download from 
the ColorMetrix website.
 http://www.colormetrix.com/downloads/

3. Plug in and install drivers for USB hardlock
After installation is complete, plug in the blue USB 
hardlock that came with your purchase a red light 
should illuminate, and Windows should automatically 
recognize the device.
If Windows does not appear to recognize the device 
go into the Hardlock folder on the CD and run the 
hldrv32 application to install the drivers for the 
hardlock. The hardlock drivers are also available for 
download from http://www.hardlock.com/
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Configuring ColorMetrix

with your instrument.
1. Plug your instrument in

2. Launch the ColorMetrix application

3. Click the Preferences button in the top file menu. A 
new window titled Preferences should appear. You 
should also be in the Instrument tab. If you are not 
in the Instrument tab, select it now.

4. From the Instrument drop 
down menu select the in-
strument you have con-
nected to your computer.

5. From the Serial Port drop 
down menu select the se-
rial or USB port which you 
have your device plugged 
into.

6. While we are in the Preferences window, we should 
check that Color Tab Au-
tomation is enabled. So 
select the Automation tab, 
and make sure the Enable 
Color Tab Automation. 
This allows you to take 
measurements more effi-
ciently in single measure-
ment mode, and allows for 
the use of scanning instruments.

7. Once you have selected your instrument and made 
sure automation is on, you can click the OK button.

8. Now you should notice a little handshaking icon 
while ColorMetrix communicates with your 
instrument.
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9. A dialog box should pop up 

asking you to calibrate your in-
strument. ColorMetrix requires 
you to calibrate each instru-
ment the first time you con-
nect to it. Follow the instructions on the screen to 
calibrate as each instrument has a slightly different 
process of calibration.

10. If you have successfully connected to the 
instrument, a little icon that looks like a con-
nected plug should appear in the lower right 
hand corner.

The next time you launch ColorMetrix, if your instru-
ment is connected, you will not have to go through 
this process. It will just prompt you to calibrate the 
instrument.

If you receive an error message, double check that 
your instrument is connected. Then check that you 
have selected the correct instrument and port for 
the instrument.

If you are still unable to connect to your instrument, 
consult the support pages on the ColorMetrix web-
site for further troubleshooting assistance.

 http://www.colormetrix.com/support/

Note: Most instruments are automatically configured 
by configured by the ColorMetrix Application, how-
ever you may wish to check the ColorMetrix support 
web-pages to see if you have to manually configure 
settings on your instrument.

 http://www.colormetrix.com/support/instruments/
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Print out a sample target
ColorMetrix can be configured to use a 

wide variety of targets. For the exam-
ples used here, we will be using a target 
we provide.

1. Navigate to the Targets folder on the 
ColorMetrix CD in the you will find two 
different colorbars, each in four different 
formats for your connivence.

The colorbars are also available for down-
load from the ColorMetrix website.

 http://www.colormetrix.com/colorbars/

2. Select the format of the “standard_
gap_colorbar” that you can output to a 
printer.

3. Continue onto the next steps while it 
prints, we won’t need it for a little bit.
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Create a new Data Set

A Data Set is the area that sample target readings are 
made into. So each time you read a target, they will 
be added to the data set, and can later be tracked 
for process control. A Data Set uses only one Color 
Bar which we will create later on in the instructions.

1. Click the Edit button in the Data Set menu bar.

2. Type a Data Set Name

3. Click the Add button

4. Click the Done Button

5. In the Data Set menu bar, the Name of the Data 
Set should be displayed.

If not, you might need to select it from the drop down 
menu. If it does not appear in the list at all, you may 
have forgot to click the Add button. In this case start 
this section over.

Training Example

1     2     3     4

data
set

menu
bar
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Create a ColorBar
In this section we will be using the colorbar you output 

in Section 4 as the “Gold Standard”. We will be mea-
suring that colorbar and using those measured values 
to compare all other prints of that colorbar to. It is pos-
sible to manually input known values, and compare 
to them also. Both methods will be discussed here.

1. Click the Data Set Info tab if you are not already in 
that tab.

2. Toward the middle and bottom of the page next to 
the Color Bar drop down menu there is an Edit but-
ton. Click that Edit button.

3. A window titled Color Bar Maintenance should ap-
pear. You should be in the Add New tab, if not select 
it now.

4. Type a name for your Color Bar in the Color Bar 
name field.

5. From the drop down menu, select the Template 
Standard ProofPass 6.

1

2

3

4 

5
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This template contains all the swatches for the color-

bar we had you print 
earlier. It also con-
tains tolerance values 
for that colorbar that 
uses a +/- 6 for Dot 
Gain, and Dot Area, 
a +/- .06 for density, 
and a Delta E of 6 for 
L*a*b* and L*C*h*.

6. Click the Add button

7. Click the Edit tab

8. From the Color Bar 
Name drop down 
menu select the name 
of the color bar you 
just created.

9. Click the Edit button. 
This should pop up a new window titled Color Bar 
Edit.

10. If everything is correct up to this point, you should 
see the Paper tab. This is the area that your paper 
measurement will be recorded into.
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Measuring method of value input

11. If you are using the EyeOne, you will need to make 
sure Scanning Measurement Mode is selected

If you are using the DTP41, you will need to click the 
Set Dimensions button. A new window will appear 
you will need to type in the Swatch Width, Gap Size, 
and Number of swatches. Then click OK.

12. You should now proceed to measure your color-
bar. Starting with paper. As you make the measure-
ments, you will notice that the tabs jump around. If 
you have your audio on, you should hear a series of 
beeps as each value is entered.

13. If you made a successful scan of the colorbar you 
should end up with the paper tab displayed.

If you did not end on the paper tab, you will need 
to click the paper tab, and measure the colorbar 
again.

14. On the Paper tab, you can enter a description for 
your color bar if you desire

On the next page we will look at some of values you 
just measured.

Note: At this point you have two options

If you want to measure the colorbar you printed as your 
“Gold Standard” for this example, follow steps 11 to 
15.

If you want to manually enter known values, skip to step 
17. Use this method if you want to match to Standards 
given to you by a customer or a standards committee 
(SWOP, GRACoL etc...)
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15. Click the Black tab. You should see the measured 

density values for the color bar you just read. If you 
click through the radio buttons at the bottom of the 
window you will see other measured values for Dot 
Area, Dot Gain, L*a*b*, L*C*h*, and Calculated val-
ues also. Click thru the other colors to see what val-
ues you just measured

16. When you are done looking at the values you 
should click save and close. You should be back in 
the Color Bar Maintenance window, where you can 
click the Done button.

Manual method of value input

17. You should now be in the paper tab, if you have 
been given L*a*b* values for your paper you can 
manually type them here, if not leave it blank

18. Click the Black tab.

19. Click the Density radio button at the bottom of the 
window.

20. Manually type the density you desire to hit.

21. Then click the next radio button for Dot Area, and 

Click through 
the tabs to 
view other 
colors

Click through 
the buttons 
to view other 
calculations

Save and 
Close when 
you are done
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enter the Dot Areas that you are aiming for. Repeat 
this process for the rest of the radio buttons, then 
proceed to the next color, and enter the values you 
are aiming for.

22. When you are done entering your values you 
should click save and close. You should be back in 
the Color Bar Maintenance window, where you can 
click the Done button.

Click through 
the tabs to 
enter values 
for other 
colors

Click through 
the buttons 
to enter other 
values

Save and 
Close when 
you are done

Manually enter values for 
all known colors and tint 
percentages
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Make a sample reading.

We have now got most of the setup work out of the 
way, and we are ready to measure a sample into 
the data set.

This section describes the most basic process of 
making a reading. This is the process that will be 
repeated over and over by the users every day. The 
only time you will need to repeat the previous steps, 
is if you are creating a new Data Set, or a new Color 
Bar.

1. Double check that the Data Set you created in sec-
tion 5 is selected.

2. Under the Data Set Info tab, double check that the 
color bar you created in Section 6 is selected.

3. In the Sample Set menu bar, click the Add New but-
ton. The sample set number should become one(1). 
Your screen should have moved to the Sample Info 
tab if you were not there already.

double 
check 
these are 
correct
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If after clicking the Add New button your screen did 
not move, you might have selected the incorrect col-
or bar to copy from in Step 5 of Section 6. You might 
need to go back and recreate the color bar.

4. You should now be able to measure your color bar 
starting with paper. As you measure the color bar, 
your screen will jump from one tab to the next as it 
fills in the measured values.

If you made a successful reading, you should end up 
back on the Sample Info tab because this is the very 
first color you read. If you do not end up on that tab, 
you may have missed a color or two. You should 
click back on the Sample Info tab and try reading 
your color bar again.

If you are unsuccessful after a few tries, you should 
double check you created the color bar properly in 
Section 6.

5. If you desire to enter a sample description, go to the 
Sample info tab and enter a description into the De-
scription field. Common descriptions range from job 
numbers to operator names to customer names.

Notes about specific instruments

ProofPass is very effective when a DTP41 or EyeOne is utilized 
to make the measurements.

If this is the case, when you click the Add New button to add a 
new sample set, the tab should switch to whichever color you 
are reading first.

For the Standard ProofPass Color bar it start on the Sample Info 
tab, because that is where paper is measured. For the Default 
ProofPass Color Bar, it will start with the cursor blinking in 
the Black 100% value field because that is the very first color 
measured.

ColorMetrix will switch between tabs and fill in the appropri-
ate data fields.  When using a DTP41 if you get a good scan 
(steady green light on the instrument) all the values should 
transfer to ColorMetrix without any further issues to consider.
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When using an EyeOne, it is important to ensure that a good 

complete scan has been made. As a general rule it is much 
easier to scan too fast with the EyeOne than too slow. It is 
suggested that the instrument be moved at a slow and steady 
pace that takes about 3-4 seconds to measure the Standard 
or Default ProofPass Color Bars.  

If the Standard or Default ProofPass Color Bars have been mea-
sured completely ColorMetrix will rest on the very first color 
measured. For the Standard ProofPass Color bar it will stop 
on the Sample Info tab, because that is where paper is mea-
sured. For the Default ProofPass Color Bar, it will end with the 
cursor blinking in the Black 100% value field because that is 
the very first color measured.
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View & Print your Pass/Fail 
reports

Now that we have made a successful scan you may 
want to output a report or label to document this 
sample. We will not cover printer set up in this sec-
tion, that is covered in the Appendix. Any printer can 
be used, but we only support and offer free premade 
labels layouts for the Dymo Label Writer 330 and 
the Cognitive Del Sol label printer. We no longer sell 
the Cognitive Del Sol, but the Dymo Label Writer is 
available for purchase off of colormetrix.com.

The next section will cover a more detailed look at 
your sample set readings.

This section will assume you have set up and are us-
ing the Dymo Label Writer.

1. When you are done making a sample set reading, 
you can print a report or label. If you want to print 
a report for a sample reading made earlier, simply 
select it from the Sample Set drop down menu

2. In the Numeric Reports menu bar in it’s drop down 
menu, select any report named “Label - Dymo  - 
Pass Fail”

3. Then click the Print Preview button in the Numeric 
Reports menu bar.

choose a label or report to view the report without 
printing click print preview
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4. A new window should appear with a preview of the 

label.

The labels will give you a Status of Pass or Fail, based 
only on what you see on the label. It will display the 
Data Set name and any sample description if you 
entered one. It will also display, depending upon the 
report selected, the measured values for Density, 
Dot Gain, and L*a*b*

5. Close the report preview window.

6. Click the Print button from the Numeric Reports 
menu bar. Your report should then be sent to your 
printer.

Select other reports and labels and click print pre-
view to view them until you find one you like. You 
may need to adjust your page size to have them 
displayed.
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Viewing Detailed Sample Data 

in the ColorMetrix Application
After making a Sample Set reading, you can print a 

report as covered in the previous section, but not 
everything appears on those reports. ColorMetrix 
gives you the ability to look at lots of other details 
inside the application. This section covers how to 
view sample specific data.

1. Select the Sample Set number you wish to view 
data about.

2. Click the tab for the color you wish to view details 
about.

3. On the left you will see the Tint Percentages, and 
the measured values. If a tolerance was entered in 
for the Tint Percentage in the Color Bar (Section 6), 
a green dot or a red arrow will appear.

Green dots represent a value that fell within the spec-
ifications you defined for the color bar. A red arrow 
indicates that the value falls above (arrow up) or be-
low (arrow down) the specified values.

On the right there should be a graph that takes up 
most of the screen. This is a plot of all the tint per-
centages for the selected color. The red lines in-
dicate the upper and lower limits specified by the 
color bar.

Across the bottom of the screen are a bunch of ra-
bio buttons. Clicking these allows you to view other 
data that you measured for the tint percentages.

Simply click through the tabs as well as the buttons 
at the bottom to view all the details about your mea-
surements.
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Click through 
the tabs to 
view other 
colors

Click through 
the buttons 
to view other 
calculations

Green dots represent a value that fell with in the 
specifications you defined for the color bar. A red 
arrow indicates that the value falls above (arrow 
up) or below (arrow down) the specified values.

These are the 
number you 
measured
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A Note about all graphs in the
ColorMetrix and Trending

Applications
Every graph in ColorMetrix is accompanied by a tool-

bar. This tool bar allows you to modify the graph 
format, and transfer the graph data into another ap-
plication. Hovering over any of the icons will display 
a description of what it does. I will only cover the 
first three.

The first icon is a camera. Clicking this icon will copy 
the graph image as a bitmap to your clipboard allow-
ing you to paste the image into another application.

The second icon is a scissors. This will copy all the 
necessary data about the graph as text to your clip-
board.

The third icon is a printer. Clicking this will print the 
graph.

Perhaps you want to send the image to a supervi-
sor to ask them why something is out of spec. You 
could open up an email to them, go to ColorMetrix, 
copy an image of the graph, and paste that into your 
email. Then you could go to ColorMetrix, and copy 
and paste the actual values

The rest of the icons allow for formating of the graphs. 
You can change colors, change the scale, and type 
of the graph.

Also there is a magnifying glass icon. Clicking this will 
change your cursor to a magnifying glass, you can 
then click and drag over the area you would like to 
zoom in on.
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Analyze Graphic Reports

ColorMetrix has a Graphic Report wizard that allows 
you to look at data collected in a few different ways. 
This section covers some parts of the wizard. How-
ever, if you follow the directions that the wizard pro-
vides you can walk yourself through the wizard and 
produce some valuable graphs.

The Graph Wizard can be launched by selecting 
Graphic Reports... from the Analyze menu in the 
File Bar menu bar.

Like the first screen says, 
you can compare two 
different data sets to 
each other, or view data 
about one data set.

After the first screen you will be asked to choose a 
data set. Then a sample range. Being able to choose 
a sample range allows you to look at the whole data 
set, just one sample, or a range of samples any-
where in that data set.
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Trending Setup
Trending is a stand alone module that provides statis-

tical process control charting capabilities. Designed 
as an enterprise product, a single copy of Trending 
can monitor a single copy of ProofPass running on 
the same computer, or many copies of ProofPass 
running on different computers on a network.

The first time you launch the Trending application you 
will need to tell it what database you want to look at.

1. Under the File menu, select 
Open Site...

2. Navigate to the location of your 
ColorMetrix.mdb file. In most 
cases this is in C:\
Program Files\Col-
orMetrix or where 
ever you decided to 
install the ColorMe-
trix application.

3. Once you find your 
ColorMetrix data-
base, click Open.

4. Trending will ask 
you to name this data-
base. Give it a logical 
name that represent that 
installation.

5. You will now have to pick a data set to view. If 
you choose the ColorMetrix.mdb file we have been 
working with your databases should appear in the 
drop down menu.

For this example I will 
ask you to choose a 
demo data set be-
cause they are already 
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populated with a lot of data, and will better portray 
the true effectiveness of Trending.

6. Along the left side is an area that allows your to 
select the graph type you wish to view. For now 
choose the KCMY Dens, by clicking the icon.

7. The first bar represents the First Tint % displayed 
in the Tint Percentage menu bar. The second bar 
represents the second tint and so on.

8. Double click on a graph.

9. You should now see a scroll bar, that will allow you 
to view scroll through all the measurements for that 
data set.

You should also see the familiar tool bar that allows 
you to copy and paste, print, and modify the graph.

10. Clicking other icons in the bar on the left will give 
you other graphs.

11. Clicking title boxes on the left will give you differ-
ent graph types, allowing you to view your data in 
different ways.
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Click these icons 
for other graphs

Click these buttons for 
other graph types
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Installing and configuring the 

DYMO LabelWriter 330
Configuring the DYMO LabelWriter 330

 1. Connect the DYMO to your computer and add 
the labels, following the directions found with your 
printer.

 2. Insert the DYMO CD which should be included 
with your package.

 3. Run the Install.exe program found on the CD. A 
wizard will assist you is setting it up.

 4. Go to the Printer and Faxes Setting and right-
click on the DYMO printer and select properties.

 5. Go to the Advanced 
Tab shown below

 6. Click the Printing 
Preferences button. 
Configure your setting 
to Landscape

 7. Click the Printing De-
faults button.

 8. Set your orientation 
to Landscape

 9. Click the advanced 
button. The window 
shown below will ap-
pear.

 10. Select the Paper 
Size of 30256 Shipping.

 11. The rest of the set-
ting should look like the 
Advanced Options win-
dow above.

 12. Click OK.
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 13. You should be pack in the Printer Properties 
window

 14. Click Apply then click OK

You have finished configuring the DYMO LabelWriter 330

Configuring ColorMetrix to print to the 
DYMO

 LabelWriter 330

 1. Choose Print Setup 
under the file menu

 2. Choose your DYMO 
LabelWriter under the 
printer drop down menu

 3. If your printing de-
faults we set correctly, the Paper size should switch 
to 30256 Shipping, and the orientation will switch to 
Landscape

 4. The print setup window should look like this:

 

Now print a test from ColorMetrix

 1. In ColorMetrix, under Numeric Reports, choose 
the proper label for the DYMO

 2. Choose any available Data Set

 3. Click the Print button next to your chosen Nu-
meric Report.
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